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Field Change Trigger 

Field change triggers are executed when a specified field is changed. The trigger will go into 

effect the moment the focus leaves the edited field. Field change triggers allow you to 

regulate and keep track of the changes made to certain fields. For example, if you wanted to 

keep an eye on an employee’s dependent count, you could set a field change trigger that 

would send you a message every time the Dependents field is changed in that employee’s 

record. That way, you can keep track of that employee’s dependents without having to check 

the employee record too often. 

The Field Change Triggers process uses a three-tab screen.  

Details Tab 
The Details tab is used to enter setup information about the trigger.  

Trigger Name The name of the field change trigger. 

Category The category into which the field change trigger is to be placed. This category can also be 

used to secure field change triggers. A table that contains all of the existing categories for the 

current module supports this field. You can only select a valid entry from the table. 

Trigger Field The field whose changes are being monitored. This field is supported by the Select Field 

popup. 

Row Modifier If the Trigger Field is a multi-row field, this is the modifier that determines which row should 

have its changes monitored. If this field is left blank, then a change in any row of the Trigger 

Field will qualify. This field is supported by the Select Row Modifier popup. 

Trigger Use The use for the trigger: Validation or Process. Enter Validation if the trigger is to be used to 

validate an entry in the Trigger Field, or enter Process if the trigger is to be used to perform 

some processing after the entry in the Trigger Field. This field is defaulted to Process. The 

Trigger Use that is selected determines what Action Types (on the Actions tab) are available. 

If the Trigger Use field is changed and there were existing actions, those actions are deleted. 

Conditions Tab 
The Conditions tab is used to define the conditions under which the trigger is to be executed. 

The bottom part of the tab uses the standard query grid.  

One thing that is unique to the query in this trigger grid is that to determine the value of a 

field, the transaction log is first checked. If there is a pending transaction for the field in the 

current session, that transaction value is used. If there is no transaction, the value in the 

database is used. This allows you to query on the most recent value of the field. 

Both the Trigger Field condition specified in the If New Value Is fields AND the condition 

for other fields as specified in the query grid (if used) must be met in order for the trigger to 

be executed. 
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If New Value Is This field is composed of two separate fields that make up the field change trigger formula: 

operator and value. 

Operator 
The operator field allows you to set when the trigger will execute. The following are valid 

operators: 

 Equal to 

 Not equal to 

 Less than 

 Greater than 

 In the list of 

 Not in the list of 

 Between 

 Outside 

 

Value 
This field specifies the value that is to be compared to the contents of the Trigger Field using 

the operator 

 

Actions Tab 
The Actions tab is used to define the actions to be taken once the trigger is executed 

Action Type The type of action to take when the trigger conditions are met and the trigger is executed. 

There can be more than one action to take, and the actions are executed in the order they are 

listed here. The action types available are determined by the Trigger Use field setting. 

The following are the action types allowed for a field change trigger that is being used for 

validation (Trigger Use = Validation): 

 Disallow Entry 

 Execute Procedure 

 

The following are the action types allowed for a field change trigger that is being used to 

perform some processing (Trigger Use = Process): 

 Assign Task 

 Display Message 

 Display Prompt 

 Display Screen 

 Execute Procedure 

 Insert Row 

 Run Document 

 Send Email 

 Send Message 

 Set Alarm 

 Update Derived 

 Update Field 
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Record Save Trigger 

Record save triggers are very similar to field change triggers. The chief difference is when the 

action is triggered. As opposed to field change triggers that are executed when a field is 

changed, record save triggers are executed when the user saves changes to a field. A record 

save trigger is useful when you want to make sure that a field change is permanent before 

doing any actions. For example, if you have a lot of trigger actions that you want to kick off 

when entering an employee termination date, it would be extremely unwise to do that using a 

field change trigger. If you accidentally enter that date for the wrong person, the result could 

be extremely painful. 

The Record Save Triggers process uses a three-tab screen.  

Details Tab 
The Details tab is used to enter setup information about the trigger.  

Conditions Tab 
The Conditions tab is used to define the conditions under which the trigger is to be executed. 

The bottom part of the tab uses the standard query grid.  

Actions Tab 
The Actions tab is used to define the actions to be taken once the trigger is executed. 

 

Schedule Trigger 

Schedule triggers are based on specified points in time. When the time is met (and the trigger 

has not already been executed on that date), the trigger is executed and its associated actions 

are taken. Schedule triggers are tested to see if their conditions are met when logging into 

People-Trak, switching between modules and executing NightRun.  

Note: The Check Schedule Triggers check box in Enterprise Setup allows you to specify 

whether or not you want NightRun to check schedule triggers. 

The Schedule Triggers process uses a three-tab screen.  

Details Tab 
The Details tab is used to name the trigger, assign it to a category, and define the Last and 

Next Execution dates.  

Last Execution  The date the schedule trigger was last executed. This date is updated to the current date by 

the system whenever the trigger is executed and is for display only.  

Next Execution The date the schedule trigger will next execute. This date is updated by the system whenever 

the trigger is executed and is based on the value in the Frequency field. For example, if the 

Last Execution date is 7-31-09 and the Frequency is Monthly, the Next Execution date would 

be 8-31-09, one month later. 

Note: If you change the conditions under which a schedule trigger is executed, you will need 

to clear the Next Execution field if it has a date in it. The next execution will then be done 

according to your new conditions. 
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Conditions Tab 
The Conditions tab is used to define the conditions under which the trigger is to be executed.  

Frequency The frequency that the schedule trigger will be executed. 

Daily     The trigger will be executed each day. If you set the Start Date 

field many days in advance, the trigger will not execute until that 

day. 

Weekly    The trigger will be executed each week on the weekday that 

matches the Start Date field. 

Monthly    The trigger will be executed each month on the day of the month 

that matches the day of the Start Date. 

Quarterly    The trigger will be executed every three months on the day of the 

month that matches the day of the Start Date. 

Annually    The trigger will be executed each year on the day of the year 

indicated by the month and day of the Start Date.  

One Time Only    The trigger will be executed just once on the day specified by the 

Start Date field. After the trigger is executed, the Active check box 

is deselected to ensure the trigger is not executed again. 

Every So Many Days    The trigger will be executed every “N” days beginning on the day 

specified by the Start Date field. The number of days “N” is 

specified in the Number of Days field. 

Start Date The start date of the schedule trigger. 

Day of Week/ 

Day of Month/ 

Number of Days 

There will sometimes be a third field in the Conditions frame depending on the Frequency 

chosen. If the Frequency is Weekly, the Day of Week field displays the verbal day of the 

week on which the schedule trigger will be executed. If the Frequency is Monthly, the Day of 

Month field displays the day of the month on which the schedule trigger will be executed. If 

the Frequency is Every So Many Days, the Number of Days field allows you to enter the 

number of days between schedule trigger activation. 

 

Note: If you set the Frequency to Monthly and the Day of Month is 28 or higher, People-

Trak assumes that you want to run the report at the end of every month. This is required in 

the event that you have a Start Date of March 31 because not all months have 31 days. 

Actions Tab 
The Actions tab is used to define the actions to be taken once the trigger is executed. 

Trigger Actions 

The following is a list of all available trigger actions. The actions that are valid for a trigger 

vary depending on the type of trigger being updated. See the Actions tab information for each 

type of trigger for a listing of valid actions for that trigger. 

 For each action, the Detail:row button allows you to enter the detail for the action. When you 

click the button, a screen unique to that action is displayed for detail to then be entered.  
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 Assign Task  Assign a task to a user 

 Display Message Display a message 

 Display Prompt  Display message with Y/N prompt 

 Display Screen  Display a screen 

 Execute Procedure Execute a procedure 

 Execute Tool  Execute a People-Trak tool 

 Hyperlink  Execute a hyperlink to the specified URL 

 Insert Row  Insert a row in a grid. Used before Update Field actions. 

 Run Document  Run a report, letter, label, etc. 

 Send Email  Send email 

 Send Message  Send a message to a user 

 Set Alarm  Set an alarm for a user 

 Update Derived  Update any derived fields on the current screen 

 Update Field  Update a field for the current record 

 

Assign Task 
The Assign Task action assigns a task to any user, including yourself. There are eight 

different types of tasks: activity, administration, create, document, edit, link, processing and 

table. Once the trigger takes effect, the selected task will be sent to the specified user’s Inbox. 

From the Inbox, the user can execute that task, which will run an activity, launch an 

administrative action, create a new record, run a document, edit records, access a link , run a 

process, or maintain a table. 

Display Message 
The Display Message action displays a message on the user’s screen. This can be an 

informative message or a reminder. The entry that executed the trigger is allowed. 

Display Prompt 
The Display Prompt action displays a prompt with a specified message and then the question 

“Do you wish to continue?”. If the user answers “Yes”, the rest of the actions defined for the 

trigger will be executed. If the user answers “No”, the rest of the actions defined for the 

trigger are skipped. This action can be used to allow the user to escape out of the sequence of 

actions about to occur. For example, if a series of reports are about to be printed that would 

take a long time to generate, the user might decide to generate the reports at a later time. 

Display Screen 
The Display Screen action displays a specified screen.  

Execute Procedure 
The Execute Procedure action executes code that is not included in standard People-Trak 

features. This code can be written by you or People-Trak, depending on the feature. 

Procedure Type The type of procedure to execute. 

Custom    Custom procedures created by People-Trak for specific customers. 

The custom code is compiled into a DLL and installed and 

registered in the People-Trak directory. 

Database    Stored procedures in the ACTIVEDB database, which is used by 

People-Trak. These may be created by People-Trak personnel (for 

SQL or Access) or by members of your own IT staff (for SQL 
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only, because Access is password protected). 

External     External procedures stored in EXE, VBS or BAT files.  

Internal     Stored procedures already included in People-Trak. 

Procedure Name The name of the procedure to execute. If the Procedure Type is: 

Custom     Enter the name of the custom procedure, if any have been created 

for you by People-Trak. 

Database      Enter the name of the procedure created in the ACTIVEDB 

database. 

External      Enter the name of the EXE, VBS or BAT file. This file must be 

stored in the People-Trak root directory so it can be shared by all  

users.  

Internal    Enter the name of the internal procedure. This field is supported by 

a popup that lists the internal procedures for the current module. 

Parameters The parameters required by the procedure, separated by commas. You can enter literals or 

People-Trak Field IDs. 

 

Execute Tool 
The Execute Tool action executes the specified People-Trak tool. This action is only 

applicable for button triggers.  

Hyperlink 
The Hyperlink action executes a hyperlink to the specified URL. This action is only 

applicable for button triggers. 

Insert Row 
The Insert Row action inserts a row in a grid and is required before Update Field actions that 

require a new, blank row. Once the row is inserted, Update Field actions can then overwrite 

that blank row with the necessary data. 

Run Document 
The Run Document action runs a specified document. 

Document Name The name of the document to run. This field is supported by the Select Document popup, 

which in this specific use includes Audit Reports. 

Group Type The group type to use to select what records to include in the report query. For Alert 

Triggers, you have a choice of Current Record or Use Query. For Schedule Triggers, you 

only have a choice of Use Query because no records are opened for that type of trigger. All 

other triggers have all three options: Current Group, Current Record or Use Query. If an 

Audit Report is selected, you only have a choice of Use Query because there are no records 

involved in those types of reports. 

Current Group    Current Group queries the whole group of the current record being 

viewed. This is valuable when you would prefer the document to 
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include all records in a certain group as opposed to only the 

current record or the whole database. 

Current Record    Current Record queries only the current record that is being 

viewed. This can be used when you want the user to view only his 

information on the document instead of all other records. 

Use Query    Use Query uses the query assigned to the document in the 

Explorer. 

Auto-Destination The destination to which the document is to be sent. 

Archive    Archives the document. 

Email    Sends emails based on the document’s email breaks and/or email 

distribution specified in the document’s properties. If the selected 

document does not have an email break and does not have email 

distribution specified in its properties, no action is taken. 

Printer    Sends the document to the default printer. Alert and Schedule 

triggers do not have this option because those types of triggers 

might be executed via NightRun. 

Viewer    Sends the document to the Document Viewer. Alert and Schedule 

triggers do not have this option because those types of triggers 

might be executed via NightRun. 

Send Email 
The Send Email action sends an email to the specified recipients. When you select this action, 

the following screen is displayed. This is the standard Send Email screen used throughout 

People-Trak.  

Send Message 
The Send Message action sends a message to the specified user’s Inbox.  

Set Alarm 
The Set Alarm action sets an alarm for yourself or another user for a specified date and time. 

It functions just like using the Set Alarm tool. 

Update Derived 
The Update Derived action updates any derived fields on the current screen. A Details screen 

is not necessary for this action. 

Update Field 
The Update Field action updates a field with a new value.  

Field Name The name of the field that is to be updated when the trigger is executed. This field is 

supported by the Select Field popup. 

Row Modifier For fields that are normally tracked on a grid, this is the row number on the grid where the 

field is to be updated. The following values are valid:   

Blank            Top row 



Workbook 

 

8     Strategic Triggers 2  

1- 99            Row indicated 

+            Bottom row 

Note: The Select Row Modifier popup screen shows codes 1-10, but higher row numbers can 

be manually entered as well. The Update Field action overwrites any existing data in the 

specified row. If you require a blank row to be inserted before the overwrite, an Insert Row 

action is required before the Update Field action(s). For example, if you want to update the 

Company Property grid with a new row of Property Type and Issue Date, you would have an 

Insert Row action inserting a row at the appropriate location followed by two Update Field 

actions overwriting that same row in the appropriate fields. 

New Value Type The type of the new value. This field is supported by the Select Value Type popup. 

New Value If the New Value Type is Derived Field or Field, this is the field that contains the new value 

and is supported by the associated popup. If the New Value Type is Value, this is the new 

value that is to be inserted into the field. 

Row Modifier If the New Value Type is Field and the New Value field is one that is normally tracked on a 

grid, this is the row number on the grid where the new value resides. Otherwise, this field is 

not used. 

 

Trigger Type/Trigger Action Matrix 

The following is a matrix showing the trigger actions that are available for each type of 

trigger. The Field Change trigger type can be used for validation or process purposes, so that 

is so noted in the table. 

 

Trigger Action Alert Button 

Field 

Change 

Process 

Field 

Change 

Validation 

Record 

Save 
Schedule 

Assign Task X X X  X X 

Disallow Entry    X   

Display Message  X X    

Display Prompt  X X    

Display Screen  X X    

Execute Procedure X X X X X X 

Execute Tool  X     

Hyperlink  X     

Insert Row X X X    

Run Document X X X  X X 

Send Email X X X  X X 

Send Message X X X  X X 

Set Alarm X X X  X X 

Update Derived  X X    

Update Field X X X    
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Tutorial 4.1 – When to Use Record Save Triggers 10 
Tutorial 4.2 – Field Change/Record Save Triggers 13 

 

 
This lesson covers when to use Record Save triggers and how to use them together with Field 

Change triggers. 

Tutorials 
When to Use Record Save Triggers: shows when to use Record Save triggers by using an 

example of when not to use them. 

Field Change/Record Save Triggers: demonstrates how to use Field Change and Record 

Change triggers together. 
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Tutorial 4.1 – When to Use Record Save Triggers 

The best way to show when to use Record Save triggers is by an example that shows when 

not to use them. 

1. On the Templates menu, select Email Templates.  

2. Create a new email template and name it Security Termination Notification.  

3. Set the Category to Status. 

4. Edit the template and enter the following text: 

 

Employee: ~F~ (insert Full Name), ID Number: ~F~ (insert Employee ID) has been 

terminated. Please take all appropriate actions to disable building access rights. 

Please send an escort to remove this employee from the premises. 

 

Thank you, 

 

~F~ (insert User Name from the System category) 

5. Close the Email Template Editor screen, saving your changes. Close the Email 

Templates screen, saving your changes. 

 

This is a good time to review how to set up an Email Definition for emails that will be 

used more than once. We are going to use the same email in a field change trigger in this 

tutorial and then again in the next tutorial. 

6. On the Administration menu, select Email Definitions. 

7. On the File menu, select New Email Definition or on the Tool Bar, click the New Email 

Definition button to start a new email definition. 

8. Change the Definition Code to Security Notification Termination. 

9. In the From Address Type field, select Address Book. 

10. Click the Address Book button and select the HR User Timothy Carpenter like you did 

in the last lesson. 

11. Set the Subject to Security Termination Notification. 

12. In the Template field, use the popup to select the Security Termination Notification 

template. 

13. Close the Email Definitions screen, saving your changes. 

14. On the Tools menu, select Field Change Triggers. Create a new Field Change trigger 

named Termination Communication. Base this trigger on the Termination Date field. 

Keep the Trigger Use field set to Process. 

15. On the Conditions tab, set the condition to be any change in the date. (Hint: New Value 

Not equal to blank.)   

16. On the Actions tab, add a Send Email action and open the Detail for it. 
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You would typically send this kind of notification to the position in your company that 

handled security. In our case, we will assume that is the IT manager. 

17. So, set the To Address Type to Position.  

18. In the To field, click the popup button. 

 

The Lookup Position screen is displayed. 

19. Click Search and then select 1005 - IT Manager. 

 

The position number for the IT Manager is returned to the To field. This allows you to 

send this email to anyone who is currently in that position. 

20. Click the Message tab. 

 

We will now use the Email Definition we created. 

21. In the Email Definition field, select Security Termination Notification. 

 

The information from our definition is defaulted. We could change this information now, 

if we wanted, but it is exactly as we need so we will leave it as is. 

22. Close the Send Email screen, saving your changes. Close the Field Change Triggers 

screen. 

 

Now let’s demonstrate the use of this trigger in a “real-life” scenario.  

23. Open Donald Stern’s record. Select the Status screen. 

 

Remember that it is Donald Stern you wish to terminate. Now, let’s assume that you have 

just taken a phone call requesting employment verification for Julie Carrington.  

24. Use the Record dropdown to select Julie Carrington and do your research. Your phone 

call is now complete and you return your attention to the Status screen and are ready to 

process the termination. (Of course, you have forgotten to return to Donald Stern’s 

record.) 

25. On the Status screen, enter a date in the Termination Date field.  

 

You will see the email simulation, but in production, nothing will be visible. You will not 

necessarily know that you have just sent an email to the Security staff to come and 

forcibly remove Julie Carrington from the premises while Donald Stern remains free to 

roam the building causing unspeakable harm. And, worst of all, we might not know for 

an hour or more, if at all. However, let’s assume we catch our mistake within minutes and 

make a few calls to fix things. If nothing else, we have wasted a lot of time and suffered 

some embarrassment when we meant to have timely communication.  

 

How can this be remedied? There are a couple of ways. One way would be to display a 

warning message before the email is sent. The other is to establish a practice of using 

field change triggers for communication and record save triggers to actually perform the 

work. Record save triggers are executed when the record is actually saved. This means 

the trigger will not be executed until all changes are made. In companies where approvals 

are being used, it means that the trigger will not be executed until the changes are 

actually approved. 
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Here is another interesting scenario. Let’s say that you have a field change trigger that 

notifies Payroll when there is a salary change. And let’s say that the salary change 

transaction is subject to approval. One day, you make a tentative salary change for 

Donald Stern. Off goes the email to payroll for a pay raise and off goes the pay raise 

transaction into the approval loop. No problem thus far. Unfortunately, two approval 

levels up, Donald’s salary change is rejected and the raise is never posted. Now, our 

overzealous communication method has caused HR and payroll to be out of sync. Donald 

is going to get a raise that was not approved and someone is going to be in trouble. Big 

problem!   

 

The ultimate solution is to use field change and record save triggers in a balanced 

combination. We’ll see how to do this in the next tutorial. 

26. Clear the Termination Date for Julie Carrington. (At least we can correct the data.) 

Close Julie Carrington’s record, saving your changes. 

27. Continue with the next tutorial. 
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Tutorial 4.2 – Field Change/Record Save Triggers 

Let’s use a field change trigger and a record save trigger together to best perform our mission. 

1. On the Tools menu, select Field Change Triggers. Select the Termination 

Communication trigger.  

2. On the Actions tab, delete the Send Email action. Add a new Display Message action, 

and open the Detail for it. Enter the following in the Message Text field: 

 

You have just set a termination date for an employee. This will set several things in 

motion when this record is saved. Are you sure you are terminating the right 

person? If not, clear the termination date to disable the trigger. 

3. Close the Display Message screen, saving your changes. Close the Field Change 

Triggers screen. 

 

This trigger is now purely informational. It lets you know what will happen (you would, 

of course, provide more meaningful details) if the termination is allowed to proceed. 

However, the actions will not be taken until the record is saved. This happens when the 

Save button is used or when the record is closed if approvals are not in use. If approvals 

are in use, the trigger will be executed if and when the transaction is actually approved, 

which is when the record is actually saved. Before we can test this, we need to create a 

Record Save trigger. 

4. On the Tools menu, select Record Save Triggers. Create a new Record Save trigger and 

name it Termination Actions. Place it in the Status category. Set the Trigger Field to 

be Termination Date. 

 

The Row Modifier is used when you are dealing with a grid field. The Termination Date 

is a single field, so we will leave the Row Modifier field blank. 

5. Click the Conditions tab. 

 

Like the Field Change trigger you learned about in an earlier lesson, the Record Save 

trigger uses the standard query grid. Enter the query equation shown below: 

 

Termination Date <> leave blank 
 

where “leave blank” means the Contents field should be left blank. 

6. On the Actions tab, add a Send Email action. Open the Detail for that action and set the 

fields as shown below: 

 

To Address Type Position 

To   use popup to select 1005 - IT Manager 

Email Definition Security Termination Notification 

7. Close the Send Email screen, saving your changes. 

 

With a termination in your organization, there might be a number of other emails sent. 

For example, you might notify IT to close down network access, payroll to prepare a final 

check, and benefits administration to generate COBRA information. In addition, the 

termination can notify the hiring manager to open a requisition for a replacement 
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employee. The more you look at the communication now occurring (for better or worse), 

the more you can automate. 

8. Close the Record Save Triggers screen. 

 

Now, let’s see how record save triggers work. 

9. Open Julie Carrington’s record. On the Status screen, enter a Termination Date. 

 

The warning message should be displayed immediately. However, no email has been 

sent. 

10. Clear the Termination Date. Close Julie Carrington’s record, saving your change.  

 

The email is not sent because the Termination Date was cleared before the record was 

actually saved. 

11. Open Julie Carrington’s record again. Set the Termination Date, and then close and 

save the record.  

 

This time, you will see the simulated email indicating that the Record Save trigger has 

been executed.  

12. Use the Record Save Triggers process to delete the Termination Actions trigger we 

have been demonstrating. 

13. This concludes this tutorial and lesson. 
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This lesson covers how to use the Execute Procedure action in triggers. 

Tutorials 
Execute Procedure: Database: shows how to use the Execute Procedure action with a 

database type procedure. 

Execute Procedure: Internal: demonstrates how to use the Execute Procedure action with 

an internal type procedure. 

Execute Procedure: External: demonstrates how to use the Execute Procedure action with 

an external type procedure. 

Execute Procedure: Custom: shows how to use the Execute Procedure action with a custom 

type procedure. 
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Tutorial 5.1 – Execute Procedure: Database 

There may come a time when the features of the provided trigger actions are not sufficient for 

your needs. If so, you may be able to utilize the Execute Procedure action. This action 

enables you to execute four different types of procedures: database, internal, external and 

custom. Each will be demonstrated below.   

 

We’ll demonstrate the Execute Procedure action using one of the Field Change triggers we 

have already created. 

1. On the Tools menu, select Field Change Triggers. Select the Termination 

Communication trigger. On the Actions tab, delete any actions that have been defined. 

Add a new Execute Procedure action, and open the Detail for it. 

2. In the Procedure Type field, click the popup button to display a list of the available 

procedure types.  

 

As indicated earlier, there are four different procedure types. We’ll start with database 

procedures.  

3. Select Database. 

 

Database procedures are written and stored in the database. A database procedure must be 

created, named, and saved before you can use it. These may be created by People-Trak 

personnel or by members of your own IT staff. Regardless of who creates the procedure, 

you must have the precise name of the procedure. 

 

For demonstration purposes, a stored procedure named VistaToBonsall has been created 

and saved in the demonstration database. It finds each record with an employee address 

with the City named Vista and converts the City to Bonsall. It is our local version of a 

hostile takeover.  

4. In the Procedure Name field, enter VistaToBonsall.  

 

The Parameters field is used if there are parameters that need to be passed to a procedure. 

The VistaToBonsall procedure does not require any parameters so we will leave that field 

blank. 

5. Close the Execute Procedure screen, saving your changes. Close the Field Change 

Triggers screen. 

 

Before we test this trigger, it should be noted that the Field Change trigger that is going to 

run this procedure is irrelevant in this matter. Changing the termination date to cause city 

names to be updated is not a typical way of doing things. However, we needed a way to 

demonstrate the feature and you are well-versed in this particular trigger. 

6. Open a record group. Browse through records noting that several of them have cities 

named Vista. Stop on any record and select the Status screen. Enter a Termination 

Date.  

 

You will not see anything happen. What has happened is that the stored procedure was 

executed in the background at the database level. In short, the database updated itself. All 

we did was trigger the procedure. 
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7. Select the Personal screen. Browse through the records again.  

 

Note that there are no more records with a city named Vista. Our hostile takeover is 

complete. Vista residents, welcome to Bonsall! 

 

Database procedures are incredibly powerful and must be used with appropriate caution. 

In addition, database procedures bypass all auditing features within People-Trak and do 

not honor the approval process. 

8. Close the record group. 

9. Continue with the next tutorial. 
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Tutorial 5.2 – Execute Procedure: Internal 

People-Trak also allows the use of internal procedures. Internal procedures contain existing 

People-Trak program code in encapsulated form with a name. You can execute the named 

procedure and obtain the same results you would receive had the procedure been executed 

where it is normally placed in the software. We’ll demonstrate this procedure using the same 

Field Change trigger we used in the last tutorial. 

1. On the Tools menu, select Field Change Triggers. Select the Termination 

Communication trigger. On the Actions tab, open the Detail for the Execute Procedure 

action. Change the Procedure Type to Internal. 

2. In the Procedure Name field, click the popup button to display a list of the available 

procedures. This list will vary over time and from module to module. 

3. Select the procedure named SwitchEmergencyContacts.  

 

This procedure is normally executed by the Switch button on the Emergency Contacts 

screen, but we are now also executing this procedure whenever the Termination Date 

changes. 

4. Close the Execute Procedure screen, saving your changes. Close the Field Change 

Triggers screen. 

5. Open Julie Carrington’s record. On the Personal screen, click the Emergency button to 

display the Emergency Contacts screen. There is a button labeled Switch that is used to 

switch the primary and secondary contacts. Click the button now. The contacts are indeed 

switched. Make note of which contact is currently the primary contact and which is the 

secondary contact. Close the Emergency Contacts screen, saving your changes. 

6. Click the Save button to save this record. 

7. Select the Status screen. 

 

Julie is currently terminated. However, the Field Change trigger will be executed as long 

as the field is changed and the change is not to clear the field.  

8. Enter a different Termination Date.  

 

Nothing visible happens because there are no emergency contact fields on this screen. If 

there were, you would see the fields change and the change color set. 

9. Return to the Personal screen and display the Emergency Contacts screen.  

 

Note that the contacts have been switched and the change color set. These changes exist 

just as if the Switch button had been used.  

10. Close the Emergency Contacts screen. Click the Save button to make the changes 

permanent, effectively setting the emergency contacts back to how they were when we 

started. 

 

Internal procedures honor auditing and approval features to the extent that they are 

programmed to do so. In this specific example, they do.   

11. Close Julie Carrington's record and continue with the next tutorial. 
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Tutorial 5.3 – Execute Procedure: External 

People-Trak also allows the use of external procedures. External procedures can be contained 

in EXE, VBS or BAT files. Either People-Trak personnel or someone on your IT staff can 

write a procedure that can then be executed using the Execute Procedure action. The 

procedure file must be stored in the People-Trak root directory so it can be shared by all 

users. We have created an EXE procedure for you to use, and we’ll demonstrate it using the 

same Field Change trigger we used in the last tutorial.  

1. On the Tools menu, select Field Change Triggers. Select the Termination 

Communication trigger. On the Actions tab, open the Detail for the Execute Procedure 

action. Change the Procedure Type to External. 

2. In the Procedure Name field, enter BONSALLDOMINATION.EXE. 

 

This procedure will select all records with the name of the city equal to that passed in the 

Parameters field and change the city to Bonsall. 

 

The Parameters field allows you to enter field IDs or literals separated by commas. These 

are then passed to the procedure. Our procedure requires a city name passed by a 

parameter. Let’s use Bonsall’s neighbor, Fallbrook. 

3. In the Parameters field, enter Fallbrook. 

4. Close the Execute Procedure screen, saving your changes. Close the Field Change 

Triggers screen. 

5. Open all records and browse to see that there are some employees with a City of 

Fallbrook. 

6. On Julie Carrington’s record, select the Status screen. 

 

Like we did for the internal procedure tutorial, we will change the Termination Date to 

get the trigger to execute.  

7. Enter a different Termination Date.  

 

The procedure includes a message to let you know the dirty deed it has done.  

8. Browse all records and check the City field. 

 

Fallbrook has been dominated by Bonsall. 

9. Close the record group. 

10. Continue with the next tutorial.  
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Tutorial 5.4 – Execute Procedure: Custom 

The fourth type of procedure is a custom coded procedure. These are written by People-Trak 

personnel for specific customers. The custom code is compiled into a DLL and installed and 

registered in the People-Trak directory. As with all procedures, the custom coded procedure 

has a unique name. We’ll demonstrate a custom procedure using the same Field Change 

trigger we have used in the prior tutorials. 

1. On the Tools menu, select Field Change Triggers. Select the Termination 

Communication trigger. On the Actions tab, open the Detail for the Execute Procedure 

action. Change the Procedure Type to Custom. 

 

A custom procedure named TESTPROCEDURE has been programmed and saved for 

this lesson.  

2. In the Procedure Name field, enter TESTPROCEDURE, being sure to enter it in all 

capital letters.  

3. Close the Execute Procedure screen, saving your changes. Close the Field Change 

Triggers screen. 

 

TESTPROCEDURE displays a message and then changes the name of the city to 

Bonsall. It is an extension of our overall hostile takeover program, but it can be run 

record by record and is not limited to cities named Vista. 

4. Open a record group. Browse through the record group until you find a City that has not 

yet been taken over by Bonsall.  

5. Select the Status screen. Set or change the Termination Date to execute the trigger. The 

message indicating what is to happen is displayed. Close the message and let’s find out if 

it worked. 

6. Return to the Personal screen and note that the City is now changed to Bonsall. Our plan 

is working. By the completion of this day of training, Bonsall will rule the world! 

 

Programmed procedures can do almost anything. They are more powerful than internal or 

database procedures. They can be programmed to honor auditing and approvals if that is 

desired. When you have a custom procedure written for you, your Support Representative 

will let you know the name of the procedure to use. 

7. Close the record group. 

8. This concludes this tutorial and lesson. 
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This lesson covers how to use multiple actions in more complex triggers. 

Tutorials 
Use Messages to Introduce Actions: demonstrates how to use messages to introduce 

actions. 

Use Multiple Communication Methods: shows how to use multiple types of actions to 

communicate what a trigger is doing or has done. 

Fill Multiple Rows in a Grid: demonstrates how to use multiple Update Field actions in a 

trigger to fill multiple rows in a grid. 
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Tutorial 6.1 – Use Messages to Introduce Actions 

It can be disconcerting to have triggers go off with little warning. It could seem as if some 

unknown force has seized control of your computer and is having its way. Worse than that, it 

may cause you to think that there is something wrong with People-Trak. This cannot be!  This 

is where message actions come in handy. Rather than just executing an action out of the blue, 

you can start with a message action to warn the user that something different is about to 

happen. Let’s create this scenario and then resolve it. 

1. On the Tools menu, select Field Change Triggers and create a new trigger. Name the 

trigger Multi-Action Test. Set the Category to Personal. Set the Trigger Field to City. 

Keep the Trigger Use field set to Process. 

1. On the Conditions tab, change the conditions to the following: 

 

If New Value is  Equal to 

                                       Vista 

2. On the Actions tab, add a Run Document action that runs the Alphabetic Employee 

List report in the General category for the Current Group. Set the Auto-Destination to 

Viewer. 

3. Close the Run Document action, saving your changes. Close the Field Change Triggers 

screen.  

 

Now let’s try it. 

4. Open Donald Stern’s record and change the City to Vista. 

 

The Document Viewer is displayed and there is a report. Do you know why that report 

was generated? Do you know what you are supposed to do with this report? 

 

This particular report was generated in seconds. What would you have thought if this 

report dragged on for 20 or 30 seconds? Since you lose control of your PC while the 

report is running, you might have thought that your PC crashed. Some impatient users 

might have already rebooted assuming the PC had crashed and could lose changes in 

process in Donald Stern’s record. 

 

There is a better way and that is to use a message action to introduce the report action. 

Here’s how to do it. 

5. Close the Document Viewer and close Donald Stern’s record, without saving your 

change. Return to the Field Change Triggers process and select the Multi-Action Test 

trigger.  

6. On the Actions tab, insert a blank row above the Run Document action already defined. 

Add a Display Message action, and open the Detail for it. In the Message Text field, 

enter the following: 

 

Attention: A report will now be generated. This will take a few seconds. When the 

report is displayed, please email it to joe@bigcompany.com. 

7. Close the Display Message action, saving your changes. Close the Field Change 

Triggers screen.  
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8. Now go back into Donald Stern’s record and enter Vista as his City again. 

 

When the trigger fires this time, you will get the message that informs you that a report is 

about to be run. The message also instructs you on what to do with the report when it is 

displayed. When you close the message screen, the report will be run. 

 

This is your first multi-action trigger. As you learn how to string multiple actions 

together in a single trigger, you can see how important it is not to alarm the user. You can 

put multiple messages in the string if you need to. 

9. Close the Document Viewer and close Donald Stern’s record, without saving your 

change.  

10. Continue with the next tutorial. 
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Tutorial 6.2 – Use Multiple Communication Methods 

A famous baseball player once said something like this: 

“Business is 90% communication. The other half is communication.” 

The point of this statement is that communication is essential. While it is possible to over 

communicate, more often than not communication is lacking. In this lesson, we’ll show you 

how to make certain you get your point across. 

1. Return to the Field Change Triggers process and select the Multi-Action Test trigger. 

Change the Trigger Field to Hire Date. On the Conditions tab, enter the condition as 

follows: 

 

If New Value is  Not Equal to 

                                       leave blank 
 

Note: The “leave blank” above indicates that you are to leave the field blank. 

2. On the Actions tab, open the Detail for the Display Message action already listed. 

Change the Message Text field to the following: 

 

This is a new hire. Remember to notify payroll so that this person will get paid. 

Remember to notify security so that this person will get a badge. 

 

Now, when you enter a Hire Date, you will receive a nice, gentle message reminding you 

to perform a few actions. Ah, but we know that a single message will not be enough. We 

need more communication. 

3. Delete the second action (the Run Document action) that was created in the last tutorial. 

Then add a new Set Alarm action. Open the Detail for this action.  

 

You learned about the Set Alarm action in Essential Tools training, but let’s review that 

action. Using this action, you can manually set alarms for yourself or for another user for 

any future date and time. When an alarm time is reached, the alarm text is automatically 

displayed. If you are not in People-Trak when the alarm is executed, it will be displayed 

upon your next login. Let’s set our alarm. 

4. Set the User ID to your user ID, DEMO. Set the Alarm Date to the date variable 

TODAY and the Alarm Time to 4:00 PM. In the Alarm Text field, add the text 

indicated in step 2 above.  

 

Now when we change a hire date, we get a message and late in the day we receive an 

alarm. Is that enough communication? Perhaps, but not for this lesson. 

5. For the third action, add a Send Message.  

 

This is another action you learned about in Essential Tools training. This action allows 

you to send messages to your own People-Trak Inbox or to the People-Trak Inbox of any 

other user. Unlike alarms, messages must be read from the Inbox and do not popup based 

on a timer. While the system is quite simple, it is secure because it is maintained entirely 

within People-Trak. Thus, it can be more secure than email. 

6. Open the Detail for that action and set the User ID to DEMO (your user ID once again). 

In the Message Text field, add the text indicated in step 2 above.  
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This message will place a reminder in your Inbox. Now you have three reminders. But, 

that may not be enough. For example, after you change the Hire Date field, you will get 

the message. However, if you then leave People-Trak and do not come back for a few 

days, you will not see the alarm or the message in your Inbox. What we really need is 

some type of communication outside of People-Trak. An email would be nice. 

7. Add a Send Email action as the fourth means of communication. Open the Detail for that 

action and set the fields as shown below: 

 

To Address Type Position 

To   use popup to select 1043 - Human Resource Manager 

From Address Type Address Book 

From   use Address Book button to select HR User Timothy Carpenter 

Subject   New Hire Notification 

Text   enter the text from step 2 above 

 

Immediately after you receive the first message, an email will be sent to your email 

address (you happen to be the HR Manager) reminding you of the actions you need to 

take. Even if you do not come back to People-Trak for days, you will still receive an 

email. Is this enough communication yet? I didn’t think so. Here’s one last method. 

8. Add an Assign Task action. Open the Detail for that action and set the fields as shown 

below: 

 

User ID  DEMO 

Task Date  TODAY  (select using the Select Date Variable popup) 

Task Type  Document 

Task Name  pick a report from the New Hires category 

 

This action will place an automated reminder in your Inbox to run a new hire report. If 

the item in your Inbox is not a sufficient reminder unto itself, simply run the report and 

obtain a list of the new hires for which you need to take action. Of course, you could 

develop a really powerful report that looks back a set number of days and lists only those 

new hires that need immediate action. But that is up to you. 

 

Now we have to test this communication dynamo.  

9. Close the Assign Task screen, saving your changes. Close the Field Change Triggers 

screens. 

10. Open Donald Stern’s record. On the Status screen, change the Hire Date. The message 

is then displayed. When you close the message, a simulated email is displayed indicating 

that the email was sent.  

 

Later in the afternoon an alarm will also pop up reminding you once again. We must 

manually check the other actions.   

11. Close Donald Stern’s record, without saving your change. Open your Inbox. You will 

see the message that was sent and the new hire report just waiting to be run. Close the 

Inbox. 

 

In this example, you have been the object of this excessive communication, but that is not 

a restriction. You can make any user or group of users the object of any or all of the 
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communication actions. With email actions, including multiple email actions on the same 

trigger, you can reach out to just about anyone. 

12. Continue with the next tutorial. 
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Tutorial 6.3 – Fill Multiple Rows in a Grid 

Let’s look at another example of using multiple actions. However, rather than running reports 

or sending messages, we will use a set of Update Field actions to put a stack of data into a 

grid. This simple example is a foreshadowing of a much more elaborate new hire process in 

the next lesson. 

1. Return to the Field Change Triggers process and select the Multi-Action Test trigger. 

On the Actions tab, open the Detail for the Display Message action already listed. 

Change the Message Text field to the following: 

 

Standard company property recorded, please issue the property promptly. 

2. Delete the remaining actions in the list. 

3. Add a pair of Update Field actions. Open the Detail for those actions and set the fields 

as shown below: 

 

Note: The Row Modifier referenced below is the first Row Modifier. The second Row 

Modifier is not used in this example. That would be used if the New Value was a grid 

field. 

 

Field Name  Property Type 

Row Modifier  1 

New Value Type Value 

New Value  Policy Manual 

 

Field Name  Issue Date 

Row Modifier  1 

New Value Type Value 

New Value  TODAY (must select using Date Variables popup) 

4. Add another pair of Update Field actions. Open the Detail for those actions and set the 

fields as shown below:  

 

Field Name  Property Type 

Row Modifier  2 

New Value Type Value 

New Value  ID Card 

 

Field Name  Issue Date 

Row Modifier  2 

New Value Type Value 

New Value  TODAY (must select using Date Variables popup) 

5. Add a third pair of Update Field actions. Open the Detail for those actions and set the 

fields as shown below:  

 

Field Name  Property Type 

Row Modifier  3 

New Value Type Value 

New Value  Keys 

 

Field Name  Issue Date 
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Row Modifier  3 

New Value Type Value 

New Value  TODAY (must select using Date Variables popup) 

 

It is important to make certain that the Row Modifier fields are set correctly, as they 

determine the row on the grid on which the data will be placed. This will overwrite any 

existing data in that row. In our case, the record is going to be new so we will only 

replace blanks. 

6. Close the Field Change Triggers screen.  

7. Click the New Employee shortcut, and then click Create to create a new employee from 

scratch.  

8. On the Status screen, enter a Hire Date.  

 

You receive the message that the standard company property has been recorded. Let’s 

verify that this was indeed done. 

9. Click the Property button to display the Company Property screen.  

 

Note that the standard company property defined in the trigger has been issued to this 

new employee. There are three individual lines with two fields on each line. We could 

have added more, but you understand the point. You can use multiple Update Field 

actions to update multiple fields, and you can use the Row Modifier field to place data on 

different lines in a grid. 

10. On the File menu, select Delete Employee and delete this new employee. 

 

We just used the Update Field action to put data in specific rows. This was OK because 

we had just created the employee and knew that there was no data in those rows. But 

what if we wanted to add data to a grid with existing data. If the grid has rows used for a 

specific purpose, then you would still want to update a specific row. But if you just want 

to add something to the end of the existing data, you wouldn’t know where the first blank 

row is. You need to use “+” modifier to do this. But if all the update field actions use “+”, 

they will all overwrite the last row. We need to insert a row before each set of update 

fields to take care of that. 

11. Return to the Field Change Triggers process and select the Multi-Action Test trigger. 

On the Actions tab, insert a row before the first Update Field action and add an Insert 

Row action. Open the Detail for that Insert Row action. 

 

The Insert Row screen is displayed. 

12. In the Grid Name field, select Company Property. 

13. In the Insert at Row field, select “+”. 

 

This will insert a row at the end of the existing data in the Company Property grid. 

14. Close the Insert Row screen. 

15. Open the Detail for the first Update Field action, which should be the Policy Manual 

update.  
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16. In the Row Modifier field, change 1 to +. 

 

This is going to overwrite the last row, which was newly inserted with the Insert Row 

action, and populate the Property Type field with a value of Policy Manual. 

17. Close the Update Field screen, saving your changes. 

18. Open the Detail for the second Update Field action, which should be the Issue Date 

update for row 1.  

19. In the Row Modifier field, change 1 to +. 

 

This is going overwrite the last row and populate the Issue Date field with today’s date.  

 

We have two more rows of data to add to our grid. They are the next two pairs of Update 

Field actions. Before each pair of Update Field actions, you need to add an Insert Row 

action as you did before the first pair. 

20. Before the second pair of Update Field actions, insert another Insert Row action just 

like you did for the first pair. Then change the following two Update Field actions to use 

a “+” Row Modifier rather than a 2. 

21. Before the third pair of Update Field actions, insert another Insert Row action just like 

you did for the first pair. Then change the following two Update Field actions to use a 

“+” Row Modifier rather than a 3. 

 

When you are done, you will have three sets of Insert Row, Update Field, Update Field 

actions all using the “+” Row Modifier. Each set will insert a new last row and then 

update that row. 

22. Close the Field Change Triggers screen.  

23. Click the New Employee shortcut, and then click Create to create a new employee from 

scratch. 

24. On the Status screen, enter a Hire Date.  

 

As before, you receive the message. 

25. Click the Property button to display the Company Property screen.  

 

The screen should look like it did for the previous new employee. The Insert Row and 

Update Field actions using the “+” Row Modifier allow you to add rows of data whether 

data exists or not. Unless you have a specific purpose for a row in a grid, this is the best 

procedure to use to add rows to a grid. If you wanted to add rows to the top of a grid, you 

would just use a “1” as the Row Modifier rather than the “+”. 

 

Archimedes once said, “Give me a lever long enough and I can move the world”.  I say, 

“Give me enough Update Field actions and I can populate a whole record”.  In case it 

hadn’t crossed your mind, you can add an unlimited number of actions to any trigger. 

26. On the File menu, select Delete Employee and delete this new employee. 

27. This concludes this tutorial and lesson. 


